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1 Introduction

1.1 Overview

EC-Inspector is a diagnosis tool for EtherCAT networks that are controlled by any EtherCAT master (EC-Master,
TwinCAT, CoDeSys 3.5.17. and higher, …) with help of the EC-Monitor.
The user needs an ENI file to start the EC-Monitor. The EC-Monitor will collect the data from the EtherCAT
network.
The EtherCAT network does not have to be changed. Only a TAP or switch is needed to collect the data.

1.2 Requirements

• Microsoft Windows 10 and above
• Microsoft .NET Framework 4 Client Profile
• Screen resolution at least 1024x768 pixel
• Memory as recommended for operating system
• Disk space approximately 40 MB
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2 Installation

2.1 Setup Process

The product can be installed by executing the setup.exe (requires administrator privileges) and following the
screen instructions:
Welcome page:

License Agreement:
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Select Installation Folder:

Confirm Installation:
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Installing EC-Inspector:

Installation Complete:
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2.2 Silent Installation

The product can also be installed in silent mode by using the command line parameters of msiexec.
Sample 1: Installs EC-Inspector into default installation folder
$ msiexec /i c:/temp/EcInspectorSetup.msi /quiet /qn /norestart /log

c:/temp/install.log↪→

Sample 2: Installs EC-Inspector into C:/EC-Inspector
$ msiexec /i c:/temp/EcInspectorSetup.msi /quiet /qn /norestart /log

c:/temp/install.log INSTALLLOCATION="C:/EC-Inspector"↪→

For more information please refer command line parameters of msiexec.

2.3 File and Folder Structure

The setup process will copy all necessary files into the following folder:
Installation directory: (Default: %ProgramFiles%/acontis_technologies/EC-Inspector)

/Doc
Release notes and the user manual

/EEC
Files for mapping emergency error codes

/Languages

• Lanugage specific files
• EC-Inspector.exe
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• EcMonitor.dll

• …
All users directory: (Default: %ALLUSERSPROFILE%/EC-Inspector)

/CAPTURE
Capture files which can be analysed in offline diagnosis mode (see Capture File) /EtherCAT EtherCAT
Slave Information (ESI) Files Can be modified via ESI-Manager ESICache.xml ESI-File-Cache for
faster access of ESI files

EC-Inspector.log
Log file

User.myusername.xml
User specific settings

2.4 NDIS Driver

The Network Driver Interface Specification (NDIS) is the specification for a network driver architecture that allows
transport protocols like TCP/IP to communicate with an underlying physical network adapter. For analyzing Ether-
CAT frames in Windows, EC-Inspector makes use of the well-known Windows packet capture library, WinPcap.
However, WinPcap was based on the NDIS 5.x driver model, and development has ceased. The latest versions of
Windows 10 do not support this old NDIS 5.x version anymore, so now EC-Inspector V3.4 includes an installation
package to install the acontis NDIS 6.x Filter Module EcatNdis.sys. With this new Filter Module and the new
NDIS Link Layer emllNdis.dll, it is now possible for EC-Inspector to work without WinPcap on all Windows
10 versions.
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3 Graphical user interface

3.1 Overview

This section gives an overview about the graphical user interface:

The graphical user interface is divided into five parts:

Menu/Tool/Status bar:
Shows current status or mode of the EC-Inspector and allows the user to change it.

Project Explorer:
Shows different views of the current network when adding an ENI file or switching to diagnosis mode.

Device Editor:
Show information about the selected device, like process variables. It allows the user to put them into a
watchlist before switching to diagnosis mode.

Short Info:
Show short information about selected device, like name, description or vendor.

Messages:
Shows notifications which occur e.g. when the EC-Monitor hat detected a change in the topology or an
error counter increased.
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3.2 Menu/Tool/Status bar

3.2.1 File

New / Open / Save / Save As / Print:
Start new configuration or open/save existing configuration

ESI-Manager:
Add, delete or export ESI and SCI files (see: ESI-Manager)

Recent Projects:
Open recent project

Exit:
Closes the EC-Inspector

3.2.2 View

Message Window:
Shows/Hides the message window

Short-Info Window:
Shows/Hides the short-info window

Refresh:
Updates the current view

3.2.3 Network

Acknowledge all warnings (active only in diagnosis mode):
If one of the error counters increase there will be a warning in the tree, sigalized with an icon. With this entry
it is possible to acknowledge all warnings in the tree. So the slaves can be monitored again and the icons will
come back with the next error. It is also recommended that the error counters of the master are cleared before
connecting with the EC-Inspector.

Inspection Report (active only in diagnosis mode):
Opens a statistic about the state of the network. Collects some useful data like error counters and so on.
Possibility to print a PDF. See Inspection Report

Take Snapshot:
Takes a snapshot from the current diagnosis state and saves it into a capture file (for more information about
the snapshots and capture files, see Capture File)

Automatic Snapshot Mode:
Activates the automatic snapshot mode to take snapshots based on the configured rules

Snapshot:
Changes the active snapshot
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3.2.4 Settings

Language:
Changes the current language

Theme:
Changes the current theme

Message Level:
Change the current message level

Capture File:
Shows capture file settings dialog

Pcap File:
Shows pcap file settings dialog

3.2.5 Help

Show User Manual:
Shows this user manual

Show Log File:
Shows the log file

Check for updates:
Enable / disable automatic update check (once per month). Also a manual update check is performed on
activation.

About …:
Show the about dialog

3.3 Project Explorer

3.3.1 Configuration Mode

There are three topology visualisation views:
Classic View
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This is a tree view with multiple levels.
Flat View

This view shows all slaves in a flat list, as they are connected in the EtherCAT network.
Topology View
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This view shows a graphical tree of all slaves, as they are connected in the EtherCAT network.

acontis technologies GmbH Page 16/73



User Manual

3.3.2 Diagnosis Mode

There are three topology visualisation views:
Classic View

This is a tree view with multiple levels.
Possible device states:

Init Bootstrap
Pre-Op

Safe-Op
Op

Flat View
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This view shows all slaves in a flat list, as they are connected in the EtherCAT network.
Possible device states:

Init Bootstrap
Pre-Op

Safe-Op
Op

Topology View
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This view shows a graphical tree of all slaves, as they are connected in the EtherCAT network.
Possible device states:

Init Bootstrap
Pre-Op

Safe-Op
Op

Possible port states:
Bad Cable Quality

Constricted Cable Quality

Good Cable Quality
If cable quality is constricted or bad, please check the error counters of the slave (for more information about
the extended diagnosis, see Extended Diagnosis).
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3.4 Device Editor

This Editor gives the user the possibility to read information of the selected monitor or slave:

3.5 Short Info

This window shows short information about selected device, like name, description or vendor:
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3.6 Message Window

Shows notifications which occur e.g. when the EtherCAT Master has changed its operation state or a slave
has been removed from (or added to) the EtherCAT network:
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4 Configuration Mode

4.1 Overview

At startup of EC-Monitor, the user will see this page:

4.2 Monitor Settings

4.2.1 Monitor

In this tab, the user can configure the cycle time. If he wants to connect to a control system, this can also be
configured. After one of thesemodes is selected, the ENI file will be imported to show the configuration:
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General

Cycle Time:
Interval in microseconds for the EC-Monitor.

TAP connected to local system

LinkLayer:
Select the Link-Layer which should be used.

Network Adapter:
Network adapter which is connected to TAP or the switch.

TAP Type:
Select the type of TAP adapter which is used. Generic is for a standard switch. Supported is also the
ET2000. More will be supported in the future.

ENI File:
Path to the ENI which is used in the network that should be monitored. The ENI file can be exported in
EC-Engineer. More Infos about the ENI file from Third Party Masters can be found here Operating with
Third Party EtherCAT Controller
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EtherCAT snapshot by EC-Inspector

Capture File:
Path to the capture file, which contains one or more snapshots ecd

For more information about the snapshots and capture files, see Capture File
EtherCAT frames captured by Wireshark

Capture File:
Path to the capture file pcap

ENI File:
Path to the ENI which was used for the captured network.

For more information about the capture files, seeWireshark File

4.2.2 Process Data Image

In this tab, the user can see all variables of the process data image.
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The variables can also be added to the watchlist, to have a better overview in diagnosis mode.

4.2.3 Watchlist Monitor

In this tab, the user can see the watchlist and remove variables from the watchlist.

acontis technologies GmbH Page 25/73



User Manual

4.2.4 Tasks + Sync Units

In this tab, the user can see the tasks and master sync units of the ENI file.

Tasks:
List of cyclic tasks and master sync units.

4.2.5 Data Acquisition

In this tab, the user can configure our Data Acuisition (DAQ) library. This library can used from EC-Insepector to
record process data in realtime.
After adding a new recorder, the user can select the variables which should be recorded and specify some

triggers:
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Variables:

Add/Remove:
Used for adding or removing the selected variable to the recording.

Triggers:

New/Edit/Delete:
Used for changing the trigger list.

If user wants to edit a recorder, he will see the following dialog:
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Name:
Name of the recorder

File:
Absolute path of the recorder file on the master system

Format:

Format of the recorder file, e.g.

• MDF (Measurement Data Format)
• CSV (Comma Separated Values)

Sample Rate:
Sample rate of the recorded data e.g. every cycle or every second cycle, …

Real time stamp:
Adds a real time stamp to the recorded data

Cycle counter:
Adds a cycle counter to the recorded data

If user wants to edit a trigger, he will see the following dialog:

acontis technologies GmbH Page 28/73



User Manual

General

Left variable:
Name of the left variable

Operator:
Operator of the trigger (e.g. =, >, >=, <, <=, !=)

Right value:
Value of the right operand to compare the left variable against a static value e.g. trigger, if variable
is greater than 5

Right variable:
Name of the right variable to compare the left variable against the value of another variable e.g.
trigger, if variable 1 is smaller than variable 2

Enable:
Enabled or disabled trigger (can be enabled from application later)

Start:
Start or stop trigger

Optional

Duration:
Duration in ms (0 = infinite) e.g. trigger should start recording for 500 ms

Count:
Trigger count (0 = infinite) e.g. trigger should hit only for 5 times

For more information please refer the manual of the EC-Master-Data-Acquisition-Library.
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4.2.6 Trigger

In this tab, the user can create, edit und delete trigger. When a trigger is hit, the monitor will stop and show
the actual state. Trigger can be created for process data and notifications. To switch to the notification
trigger select the tab in top right corner. This tab is also shown in the diagnosis mode to enable and
disable trigger while in diagnosis mode.

Trigger:
List of trigger.

Edit Trigger:

New: When new is clicked the following dialog pops up:
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The user can select variable which should be compared and the select if he wants to compare with a
value or another variable. With enable the trigger can be enababled and disabled.
The following dialog pops up on the notification trigger tab:

The user can select which notification should be triggered. He can also select for which slave the
notification should be triggered. Default is “All slaves”. It is also possible to trigger all notifications
for all slaves.

Edit: Edit the selected trigger
Delete: Remove the selected trigger from project
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If the EC-Inspector stops because of a trigger it can be restarted with Run. It is also possible to pause the
EC-Inspector without a trigger:

4.3 Slave Settings

4.3.1 General

In this tab, the user can see general slave settings like station address or the name of the slave. He can also
see the connected ports.

Address

Station Address:
Station address of the slave. By default, the first station address is 1001.

Information
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Name:
Name of the slave. By default the following format is used “Slave_N [TYPE]”

Vendor:
Name of the vendor the slave

Product Code:
Product Code of the slave

Revision Number:
Revision Number of the slave

Identification Value:
Identification Value of the slave

Ports

Connected Devices:
List of connected devices

4.3.2 Variables

In this tab, the user can see the variables of the slave.

Lists of Variables
Variables comes from the import of the ENI file.

Buttons

Add to watchlist:
Adds the variable into the watchlist
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5 Diagnosis Mode

5.1 Overview

EC-Inspector is a diagnosis application specifically developed to analyze EtherCAT networks that are controlled by
an EtherCAT master. Automated control systems usually require high availability of the whole system. Due to the
rough industrial environment this is often hardly to achieve.
If high availability shall be guaranteed for an automated control system it is important to verify and maintain the field
bus. With EC-Inspector it is possible to take a look into the “health” of the EtherCAT system. Detection of signs of
system degradation prior to running into a system failure will be of great benefit. In that case it is possible to exchange
the problematic components (cables, slave devices).
Many aspects of diagnosis are covered by the EC-Inspector:

• System analysis and maintenance
• Error detection
• Documentation

After switching into diagnosis mode of EC-Inspector, the user will see this page:
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5.2 Monitor

This section shows the current “health” state of the master and helps the user to analyze master related problems.

5.2.1 General (Monitor)

In this tab, the user can see the current state of the state machine of the master. He has also an overview
over the current “health” state of his EtherCAT network:

State Machine

Current State:
Current state of the master

Requested State:
Requested state of the master

Information

Number of found slaves:
Number of slaves, which were found from monitor on the network

Number of slaves in configuration:
Number of slaves, which are configured in the ENI file

Number of DC slaves:
Number of slaves with DC support, which were found from master on the network

DC in-sync:
Signals that all slaves with DC support are correctly synchronized or not. If not all slaves are correctly
synchronized, please refer the Message Window for more information.
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Topology OK:
Signals that topology is “okay” or not. If topology is not “okay”, you have a mismatch between the
configured bus and the currently connected bus. Please open the ‘Network Mismatch Analyzer’ (Menu
Network Network Mismatch Analyzer) to solve the problem.

Link Connected:
Signals the link is connected.

Slaves in Master State:
Signals that all slaves are in master state.

Frame Counter

Sent frames:
Number of sent frames

Lost frames:
Number of lost frames

Cyclic frames:
Number of cyclic frames

Acyclic frames:
Number of acyclic frames

5.2.2 Process Data Image

In this tab, the user can see and change the values of the process variables. The variables will be forced to
the value the user entered. The user can press release to release the variable. If one or two variables
are selected, a chart of the values is shown. Also resize and zoom is possible to see more details. The
chart will be updated every 250 milliseconds:

It is also possible to add the variables to a watch list (next chapter).
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5.2.3 Watch list

In this tab, the user can monitor selected variables. He can go through the slaves and add variables to the
watch list to monitor them. The user can also export or import the watch list, so changes can be saved:

5.2.4 Performance

In this tab, the user can see the busload per cycle and per second:
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5.2.5 Data Acquisition Diagnosis

In this tab, the user can start and stop the DAQ recorders. Also he can see some statistics of running
recorders.
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5.3 Slave

This section shows the current “health” state of the selected slave and helps the user to analyze slave related problems.

5.3.1 General (Slave)

In this tab, the user can see the current state of the state machine of the slave:

State Machine

Current State:
Current state of the selected slave

Requested State:
Requested state of the selected slave

Error State

Current:
Slave error which occurred during state transition
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5.3.2 Variables

In this tab, the user can see and change the values of the process variables. The variables will be forced to
the value the user entered. The user can press release to release the variable. If one or two variables
are selected, a chart of the values is shown. Also resize and zoom is possible to see more details. The
chart will be updated every 250 milliseconds:

5.3.3 ESC Register (Expert)

In this tab, the user can see the values of the registers. In the settings section he can set the offset and the
length. If he activates the compact view, he will only see the registers which have a description:
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5.3.4 Extended Diagnosis

In this tab, the user can see the extended diagnosis information:

There will be a red ! to signalize that a counter is higher than 0. Except for the forwarded errors.
If an error counter is ‘-’ it was not read. If it is ‘0’ it is really zero. So there is a difference between ‘0’ and ‘-‘.
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Common Error Counter

Processing Error Counter:
Indicates that slave received “not EtherCAT frames”, which are not allowed in the EtherCAT segment
(of course acceptable in a test environment)

PDI Error Counter:
Counts if a PDI access has an interface error (read from register: 0x30D)

Port 0..3

• Invalid Frame Counter of Port y (read from register: 0x0300+y*2)
• RX Error Counter of Port y (read from register: 0x0300+y*2+8Bit)
• Lost Link Counter of Port y (read from register: 0x0310+y)
• Forwarded RX Error Counter of Port y (read from register: 0x0308+y)

Acknowledge warning
If one of the error counters increase there will be a warning in the tree, sigalized with an icon. With this button
it is possible to acknowledge this warning. So the slave can be monitored again and the icon will come back
with the next error.

To see this information the error counters must be read by the EtherCAT master. Only if this is activated the monitor
is able to read this. Here is a quick overview on how to activate this function on different masters:
acontis EtherCAT Master:

To activate the error collection of the acontis EC-Master, the follwing API has to be called:

/* Slave statistics polling for error diagnostic */
EC_T_DWORD dwPeriodMs = 1000;
dwRes = ecatIoCtl(EC_IOCTL_SET_SLVSTAT_PERIOD, (EC_T_BYTE*)&dwPeriodMs,␣
↪→sizeof(EC_T_DWORD), EC_NULL, 0, EC_NULL);
if (dwRes != EC_E_NOERROR)
{

EcLogMsg(EC_LOG_LEVEL_ERROR, (pEcLogContext, EC_LOG_LEVEL_ERROR,
↪→"ecatIoControl(EC_IOCTL_SET_SLVSTAT_PERIOD) returns with error=0x%x\n",␣
↪→dwRes));

goto Exit;
}

Third Party Master:
Find more details here Operating with Third Party EtherCAT Controller

5.3.5 CoE Object-Dictionary

This tab consists of 2 modes:
Description from ESI

In this tab, the user can see the description of the object dictionary from ESI and the values from the slave.
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Lists of CoE Object-Dictionary entries

• Entries comes from ESI

• The “Flags” column tells the user if this entry is an PDO entry and if it can be edited

– “AA BB C D (EE FF GG)”
– AA = Mapping as RX PDO or not
– BB = Mapping as TX PDO or not
– C = Backup Flag
– D = Settings Flag
– EE = Access rights for PreOp (RO, WO, RW)
– FF = Access rights for SafeOp (RO, WO, RW)
– GG = Access rights for Op (RO, WO, RW)

Single Object
In this tab, the user can read the values of the object dictionary of the slave.
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Settings

Index:
Index of the CoE value

SubIndex:
SubIndex of the CoE value

Size:
Size of the CoE value (only used for reading)

Complete Access:
Activate, if complete access mode should be used for reading or writing the CoE value (can be used only
if it is supported from slave)

Operation
Read:

Reads the value from slave (Hex format, like: “00 11 22 33 …”)
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6 Operating with Third Party EtherCAT Controller

6.1 Beckhoff TwinCAT

This section shows how to operate with Beckhoff TwinCAT.

6.1.1 TwinCAT ENI

In the EtherCAT tab in TwinCAT is a button “Export Configuration File…”. The “Export Configuration File…”
button opens a “Save as” dialog for saving the XML master configuration file. This file describes the process data
and the transfer frames that are sent during the EtherCAT state transitions. This is the ENI file, that can be used with
EC-Inspector.

6.1.2 Activate TwinCAT Error Counters

At the EtherCAT master, select Properties and then select all hardware counters that you would like to
monitor.

6.2 Codesys

This section shows how to operate with Codesys. Codesys is supported from version 3.5.17. and higher.
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6.2.1 Codesys ENI

Command ‘Generate EtherCAT XML’. The command is not integrated in the standard main menu. You can add it
via the dialog box Tools, Customize from the category Devices. This command opens the standard dialog box for
saving a file in the local file system. You can define a name and a storage location for an xml file, in which CODESYS
is to store the EtherCAT configuration of the EtherCAT master currently selected in the device tree. Call: Context
menu of an EtherCAT master device object in the device tree.

6.2.2 Activate Codesys Error Counters

The error registers are not read cyclically. With the function block readmemory from the EtherCAT Library this can
be realized within the application.
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7 Additional Tools

7.1 ESI-Manager

ESI-Manager can be found through the main menu File -> ESI-Manager.
This dialog helps the user to administrate his ESI and SCI files. Here, he can add/delete/export ESI and

SCI files.
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7.2 Capture File

A capture file could be helpful, if you have a very large system or system is not always available. In that case you can
connect to your system, save one or more snapshots into a capture file and analyse the created capture file later.
Another use case is, that your system from time to time has some problems. In this case you can activate the automatic
mode and create the snapshots every specific interval or based on specific master notifications.
At the moment there are the following options:

Filename

Folder:
Path, where the capture files should be saved

Base file name:
Base file name of the generated capture file name

Date:
Activate, to add the date to the generated capture file name

Time:
Activate, to add the time to the generated capture file name

Automatic Mode

Interval (min):
Time to wait until next snapshot will be taken

Maximum Snapshots:
Enter count of maximum snapshots
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After the snapshot(s) is / are made in diagnosis mode they can selected in the overview in config mode:

After the selection switching to diagnosis mode is possible. In the toolbar will be an additional combobox to
select the snapshot and switch between them:
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7.3 Wireshark File

With the EC-Inspector it is possible to analyze a previous recorded catupre file pcap or pcapng.

Therefore a wireshark have to be captured and saved as pcap or pcapng. Then it can be selected in the starting view
of the EC-Inspector. Also the ENI file has to be selected.

It is also possible to read multiple files. Therefore the pcap files have to named like that: name.00000.pcap.
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On switching to diagnosis mode the file will be read by EC-Monitor. After that the file is in play mode. It is possible
to play the file faster or slower or select pause. There is also a function to execute a specified amount of cycles. This
can all be done in the toolbar:

7.4 Pcap File

With EC-Inspector it is possible to capture a pcap file, same as Wireshark. Open Settings/Pcap File and
the follwing dialog appears:
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Filename

Folder:
Path, where the pcap files should be saved

Base file name:
Base file name of the generated pcap file name

Date:
Activate, to add the date to the generated pcap file name

Time:
Activate, to add the time to the generated pcap file name

Output format:
The output format can be selected. Pcap or pcapng

Create a new file automatically:
A new file is created after one of the multiple file switch conditions is met. They will be named:
name.00000.pcap. With the ringbuffer option a file is created if value is not reached, otherwise it will
replace the oldest of the formerly used files (thus forming a “ring”). This mode will limit the maximum
disk usage, even for an unlimited amount of capture input data, only keeping the latest captured data.

On the toolbar will be a new button in diagnosis mode to start and stop the pcap file recorder:
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It is also possible to record a pcap backtrace file. When EC-Inspector is in pause mode (e.g. from a trigger condition)
the user can capture the last 64 frames via the backtrace button in the toolbar.
After the capture is made in diagnosis mode it can be selected in the overview in config mode as described in the
previous chapterWireshark File.

7.5 Inspection Report

If you want to print or show a report about the actual session, it is possible with the inspection report. I
shows a lot of different data about the network communication. It is also possible to print a PDF.
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8 Customization

8.1 Multi-Language-Support

EC-Inspector supports multiple languages, which can be changed at runtime. Adding support for further lanuages is
quite easy because it is just a simple XML file which must be added to the kit.
All language files are stored in: "%ProgramFiles%/acontis_technologies/EC-Inspector/
Languages/...

EC-Inspector has also full UNICODE support, which means that it is also possible to support Asian
languages:

8.2 Themes

EC-Inspector supports multiple themes, which can be changed during compile time. Adding support for further
themes is quite easy because a theme consists of a couple of XAML files which must be added to the kit.
Five themes are already included into EC-Inspector:
IG Theme

acontis technologies GmbH Page 54/73



User Manual

Office 2010 Blue Theme
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Office 2007 Black Theme
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Office 2007 Sliver Theme
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Luna Theme
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9 Licensing

9.1 Overview

For EC-Inspector we have two license models:
• Node Locked License
• Floating License

9.2 Node Locked License

If you choose this license model, you need an USB dongle for every single computer. This dongle must be plugged
into the computer where you want to use EC-Inspector.

9.3 Floating License

If you choose this license model, you need only one USB dongle with multiple floating licenses. This dongle must be
plugged into your license server and all client computers will connect to this license server.
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Note: This requires that the “WebAdmin” of the “Code Meter” is installed on the system. Please download and
install the “Code Meter Runtime” from WIBU: https://www.wibu.com/

9.3.1 Configure License Server

Install the “Dongle-Version” of EC-Inspector on your license server, plug-in your USB dongle and open the
“WebAdmin”:

In the “WebAdmin” navigate to “Configuration Server”, select the option “Run Network Server” and press
Apply:
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9.3.2 Configure Client Computer

Install the “Dongle-Version” of EC-Inspector and open the “WebAdmin”:

In the “WebAdmin” navigate to “Configuration Network”, press add, enter your IP address of your license
server and press Apply:
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Now, you should be able to start EC-Inspector.

Note: If too many clients are connected you will, you will receive the following error message:

In that case, you should try to close unused EC-Inspector instances or buy more floating licenses.
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9.4 License Update

9.4.1 Request License Update

Step 1: Install the “Dongle-Version” of EC-Inspector and open the “CodeMeter Control Center”:

If the selected license is a virtual dongle, simply drag and drop the WibuCmLIF file onto the CodeMeter Control
Center. Otherwise, the dongle should already be visible.
Step 2: In the “CodeMeter Control Center” open the “CmFAS Assistent” by clicking on License Update:

Step 3: Now, follow the assistant until you can select a file name:
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Step 4: Select “Create license request”:

Step 5: Select “Extend existing license”:
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Step 6: Keep the selected the vendor:

Step 7: Select the file name:
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Step 8: Finish the assistant:

Step 9: Your license request file *.WibuCmRaC has been successfully created. Please send it to sales@acontis.com
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9.4.2 Install License Update

After you have been sent your license request file you will receive the license update file *.WibuCmRaU.
Step 1: Connect your dongle.
Step 2: Copy the license update file to your desktop.
Step 3: Double-click on the license update file:

9.5 Dongle Firmware Update

Step 1: Install the “Dongle-Version” of EC-Inspector and open the “CodeMeter Control Center”:

Step 2: In the “CodeMeter Control Center” click on Update Firmware of selected Cm Dongle:
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Step 3: Execute firmware update by pressing OK:

Step 4: Wait until firmware update was executed:
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Step 5: Firmware update was done and dongle can be removed:

9.6 Expiration Date Dongle

If you chosed a expiration dongle you can find your expiration date in the ‘About Dialog’. If you have an
unlimited dongle you will not see a date in the dialog.
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If you see this date you can not use an Engineer which was released after the expiration date, but all older ones are
possible.
If you try to start an Engineer which is newer than the expiration date, you will get the following error:
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10 FAQ, Tips

10.1 Help in case of a problem

If you have a problem with EC-Inspector or something does not run as expected, please try first the following things:
• Read messages in message window
• Increase message level Menu ‣ Settings ‣ All Messages
• Read log file for more information Menu ‣ Help ‣ Show ‣ Log ‣File

• Restart EC-Inspector and try to do it again
• Contact support by sending a mail to ecsupport@acontis.com and attach the following information

– Project file .eci
– EC-Inspector Version Menu ‣ Help ‣ About
– Log file Menu ‣ Help ‣ Show Log File

– Short description how the reproduce it

10.2 Shortcuts

EC-Inspector supports shortcuts for the most commonly used actions, like:
Menu

• Ctrl + N: Create new project
• Ctrl + O: Open project
• Ctrl + S: Save project
• Alt + F4: Exit program

10.3 FAQ

Solutions for possible problems:
• EC-Inspector reports a message with ErrCode: 0x…

Error Codes sent directly from the EC-Monitor. If you want to know what to know how to solve this
problem, please refer the manual of EC-Monitor.

• Connect to local system is not possible
Is Npcap / NDIS installed?
Is at least one network adapter installed?

• Permanent fram loss while monitoring TwinCAT
Please try with Npcap instead of NDIS driver

• WebAdmin in Dongle-Version shows page not found, what can I do?
You have to download and install the Code Meter Runtime from WIBU https://www.wibu.com/
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